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1. Application software is a program, or group of programs, designed for end users

to perform specific task. . . 4 .
53330 plgn £199 ¢y gl pasiiundl ol on Aaan gl A a5 Ealin 94 G A0

) True
() False

2. Examples include applications ikl Lo AL

() Database programs
() Word processors
() Spreadsheets

() Allof above

3. Application Software can further be classified as General Purpose Applications

and Special Purpose Applications. o L
Dl 2 Y1 il alall el 2 Y1 ikt W el S Likil peal ol sl (S

Aalall
(1 True
() False

4. The Special Purpose applications, such as Word, Excel, PowerPoint and
Microsoft Edge.

2 gy Sy ¢ ity gny QusSly €399 ¢l Aualdll ial 2 V) Sl

() True
) False

5. Which of the following example on Special Purpose

Lalall clinkaill e A8l ey JEN e g

() Word
()  Excel
() PowerPoint
()  Air Traffic Control System
A e L) Anala Ay ppudand plat 9V S 5 B M cOpy.com 4iiSa 520 b5 ghaa (B gkal) gran
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6. Application software may simply be referred to as an application.

Gabs il e éﬁ]a:ll&‘lju]]iﬂ.uy_;uéﬁ

() True
() False

7.A______isacollection of two or more software programs that are
bundled and sold together.

Lo Lgnr g Lgagant iy Al el ol o 31 ol () (10 A sann (g0

() Word

() Excel

() PowerPoint
() _ Software suite

8. The examples of a software suite are Microsoft Office and Adobe Graphics.

S eyl 5 ol gy Sila el sl Aa e AR

(1 True
() False

9. MS Office 2013 is the latest release of the Micrdsoft Office suite.

nsh gl gy JSa g (o sl iinl (o8 2013 G i gy S

() True
(@) False

10.MS Office is the most widely used productivity suite having the general purpose
applications useful for the corporate office environment or to a home user,

pladl (i jall Ciligglas anial al y (31 e Radiiune ) L Ja S (2 (s ol 28 gy JSie
gt il paiiaadl ol AS 20 CiiCa Dl sauial)

() __True
() False
g llal) dnalp 4 paad plat <) g¥1 (S 5 £ i cOPY.COM 4% (sl ABghaa (Fokall gian
©ashraf 2017 2 0599814114 (AU ;9! i) |

Scanned by CamScanner



Microsoft WORD 2016 -

11. is the phrase used to describe "using a computer to create, edit and
print documents".

u..)".);"_, Gl aiias ;'I.uu‘f t..-l-nla. 1.‘.'\:;.“‘ “i._l..-.ﬁJ.l Ml a_)'l..la.“ (}‘ ua_,.n.a.h“ 4&.“-!-‘

" el
() __ Word processing
() Excel
() Power point
() DataBase

12.The major advantage of Word Processing is that you can make changes without
retyping the entire document.

ALSL et Aol sale ] ()50 G s ilaa) LK) 8 o peail) Aallaad Lpssi )1 5 juall

() True
() False

13.A word processor provides the following common features
Al ALl <l pall g el pellaa iy
Spell Checker
Find & Replace
Formatting
() __ All of above

14. Which of the following is a word processing software.

(aseaid o gtisn ins A Ot 1)
() Microsoft Word 2016
() Apple Pages
()  Corel WordPerfect

All of these

15.To start MS Word click Start Button to open Start menu --> Microsoft Word

2016. ‘
‘Word 2016 < g g Sk € wma Aadldll gai! ) plida bia) MS Word gl gl

() True
() False
3 g Al daaly &y jpaaad plal ~J8¥) (S 55 £ ik COPY.COM 48 (52 4B ghaa (G ghal) pjan
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16. A Ribbon is a set of toolbars placed on several tabs.

(Sl s 4 sana o (5 giag 9V By p)
() True
() False

17. is a special tab which only appears with some objects like picture,

chart, table etc.
Al Slagu )l | gl B LS ey pa REb gl geld cupd 4 )
| (@ Jslady

() View Tab

() _ Contextual Tab ) < gaill
() Ribbon

() None of these

18. The Dialog Box Launcher is a button with a small arrow on it which appears in
the lower right corner of many groups.

(e sanall Jinl (Hagdl 41 3 (B iy sihea pgn g 1) 94 Il (Fgdia g3 04)

()  True
¥ False

19. The Insertion point is the place in the document where you can insert text,

images, graphics etc.
(& Glaguy 3@ el ) ) gahaind Sua aliuall (A GlSAl) sa ) 2Y) Akdi)

(] True
() False
20. allow you to view your document in different views.
(vase (b daay il (& dll ey )

() Status Bar

() View Buttons

()  Zoom Buttons
() None of these

a2dl ) 5
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2. allowyou to zoom in or out of the document.

(Al sy gy M anss )

() Status Bar
()  View Buttons
() Zoom Buttons

()  None of these

22.You cannot remove a command from Quick Access Toolbar.

(wﬂid”jlh'ﬁcy‘)ﬂjﬂjﬂi.em@h&uﬁ il )

() True
() False
23.When you move your mouse over most command buttons a is
displayed.
AL i o AV 5 s paglall dlyjal aie
() Help
() Tooltip Zesalill 510/
() Ribbon
() All of these
24. are a set of keyboard shortcuts used to access the Ribbon

Loy pal ) gus gl paiids griliall da o) Gl gl (4 A8 gana

() Tooltip
() Ctrl+C Ctrl+Xand Ctrl +V
{ ) Access Keys S puca ol peiilie

()  Allof these

25.Ribbon Display Options provides just two options

Ll oy )l Bl byl (e Gl LA

() True
() False
dgna dlall dnala & paiaad plal =J9¥1 (S5 £ bE cOpyY.cOM 4fiSa (5] 4B ghae (§ghadl ajan
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26.This option always show Ribbon tabs and commands.

aV) )0 gl gy S 138
() - Auto-hide Ribbon
() ShowTabs

() Show Tabs and Commands

() Nothing from above
27.To show Access Keys on the ribbon press key from the keyboard.

bl 4a o) (ya il Jay ) o Jgua gl piilia Sanldal

() Ctrl
() Shift
() Alt
{ ] Tab

28.In Word 2016 user interface screen, you might have noticed a text box on the
right of the ribbon tabs with a bulb sign that says

Lo 80 (5 cladle (g (o i e Adan e liSay ¢« 2016 295 pdiue dgal y Al
SRV VA PR SN R P S PR E B

() Tell Me

()  Smart Lookup
() Tooltip
() Reviewtab

29.1t allows you to get the definitions, Wikipedia articles, and top related searches
from the web about any word or phrase in your document.

Jsn sl oy dleall @3 iadl lilae aal g Loy g SYa y iy 2il e J geasl) ol o
Al L33 jle ol A4S 4l

() TellMe

() Smart Lookup
() Tooltip

() Reviewtab

3 gta L) daals &y jpans plal ) oW1 (S5 B cOpy.com &5 sl AL gina (3 ghall giay
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30. ______isapre-designed document created for common purposes such as a
fax, invoice, or business letter.

Jand) () 919 550 odl) SN Jia e CilAAY £ i) Wjbu paas dlia ;

() Charts
() SmartArt
() Template =y,

() All of these

31. To create a new document click on File --> New --> Blank Document --> Create.

SUED | f aliene | waa ) cile bl aa alie LAY

True
() False
32.Press the key to leave a space between each word.
AalS S (o Adlusa & S glia o bl
() Al
()  Spacebar
() Ctrl
() Shift
33.Word Wrap allows you to type in continuously without bothering about the end
of lines.
[ True
() False
34.Press the key when you want to end the current paragraph and start
with a new one.
saaa oAl cadly Al 5 Eill elgs) &y 55 Lavie ZUd e L)
() Al
() Spacebar
() Enter
() Tab
3 g dllall Analp &y ppand plal 1901 (S5 S cOpY.COM AiSa sl Al ghaae (3 ghall gpan
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(N
35.The ____key allows you to leave some blank space and enter the text away

in a line instead of pressing the Space key multiple times.
te aall e Yy a4 1y il QL] 48l dalue (any o 5 il el sy
Sl e B2 CL_I.IA-‘II ’

—

() Alt

() Spacebar
() Enter
() Tab

36. A single word can be selected by double clicking on it.
Agale 7 9d jall adudall Ao gy L yaas adaind 3aa) g Aals

() True
() False

37.To select a paragraph, position the mouse on the paragraph and click

times.
iy g 580 e ugtally daa 588 aad)

o
() 2
() 4
() 3
() 1

38.To select all text in a documentpress ___ from keyboard.

piliadl dagl e skl Al (b Gail) JalS yaall
() Shift+A .
() Alt +A
() Tab+A
() Ctri+A
39. key deletes individual characters to the right of insertion point.
E1oM Ak Gy Of 3oy i ey
()  Backspace
() Home
{ ) Delete
() End
3 g L) dawalas 4 puuaad plal <] g¥) 855 £ LS cOpy.com 4siSa (541 45 ghaa (3 ghal)
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40. __ keydeletes individual characters to the left of insertion point.

I Ak Jluy 08 2aly i ey

-

() Backspace

() Home

() Delete

() End

41. To delete an entire word in MS Word document, you may use for

words to the right of the insertion point.

Al ey o ASH ladie) gkl , word CgaguSie b AlalS AulS gl
zlN

()  Ctrl + Backspace

() Ctrl + Delete

() Delete

L] Backspace

42.To delete an entire word in MS Word document, you may use for

words to the left of the insertion point.

Akl o dalsl pladiul aghiud | word c.i_,.._,_,s,uq.iu.ui.ds@..d
Eb.‘l\"

() Ctrl + Backspace

() Ctrl + Delete

() Delete

() Backspace

43. Ctrl + Z is shortcut for Redo and Ctrl + Y is shortcut for Undo

Ctri+Y &l Jallly Ctri+Z paki jluaidl

() True
() _ False
3 gt L) el &y ppuiaad pla!l Jg¥1 (S5 B Mk cOpy.cOm 4iSa (g3l AT ghane (4 ghal) pjay
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44.Keyboard allows you to navigate through a document using the four arrow keys:

Db pel 4 il il P (e JEEVL Sl s gdliall 4a )
1. Left Arrow Key :
2. Right Arrow Key
3. Up Arrow Key
4. Down Arrow Key

() __ True
() False
45.To opeh the navigation pane activate the tab.
s (o JATN) JRY) S ¢ 33 gl
() File
() Review
() View
() Insert

46. option takes you directly ta the required page, paragraph, section etc.
by inserting desired page number. :

daiiall o) 13 Aal gy o gllaall adudall of 3 AR ) dadecll I o pdilpe S3AY LA

() InsertTab

() Headerand Footer

() Hyperlink

()_GoTo

47. In MS Word 2016, the Office Button is replaced by the on the ibbon.
cile oy 0 Al g J3dud Office 1) MS Word 2016 (4

() HomeTab

() Quick Access Toolbar

() FileTab

() Noneofthese

3 g AL sl &g paat pal LY S5 £ & COpy.cOM in (581 LB phae (3 gkad) ppan
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N
48.File Menu is also called as the Backstage View.
Backstage ‘el o wile 4ailk

() True
() ‘False

49.A regular word document is saved with the extension ".docx"
.docx a¥) aa Lale 3ol iy

()] True
() False

50. Which of the following is used to save your document.
it Bial il ‘.,.N.'aﬂ O gl

() File Tab-->Save
() Quick Access Toolbar

() Ctrl+S
() Al of the these
option is used to save an existing file with a new name, different

51.
folder, different location, and different format.
&M’&&J%@@%HleNM!MMJ@

() Save
() SaveAs
() Ctrl+S

() Allofthese

52. By default a word document is saved with the extension
ey aa Bidag 3¢ it Al 38 45 Hhy

() ___.docx

() .doc
() .doctx
() None of these

3 gtan bl Analy 4 ppadaad plal ~15¥) (S5 £ cOPY.cOM 4iiSa (5l 4B ghaa (3ghal) pyay
11 0599814114 (5,8l i 21 |

©ashraf 2017

Scanned by CamScanner



—
@ - Microsoft WORD 2016

53.Allows you to save the document locally on the computer. You can choose from
the recent folders shown on the right side.

ilall e Jgk:qﬂlip‘ﬂaligallg.j;s‘ﬂdﬁqhs‘wbmuht;h.mdlhi;eﬂ@fxg

oY)
() OneDrive
() This PC
() Browse
() Addplace

54, Which of the following is used to close a document.

Alaall (PIEY padiey AGN G 5
() FileTab-->Close
() XShaped Icon at Top Right Corner

() ctri+W
() Allof these

55.Right clicking the MS Word Application Icon on the taskbar displays a Jump List.

d,.a,nmg;wm@xm?wmﬁuhwmmﬁuzmg

() True
() False

56.Ctrl + P is keyboard shortcut for printing a document.
ATial) do ikl jlaiil ga Ctrl+p

() True
() False
57. Tab is generally used for formatting of document.
Alluall d,u.-.‘ﬁ] LBle 2080y 1o goud

() File
() Home
() Insert
() View

3 gt Al dnaly &5 ppdaas plal I gV1 S 5 £ S copy.com 43S s Aghas 3skal) aian
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58.The Home Tab commands are divided into five groups: .
' A S gaza 5 ) pusla Home uiss

1, Clipboard
2. Font

3. Paragraph
4. Styles

5. Editing

() __ True
() False

59. group contains the main editing commands such as cut, copy, paste.

ualy el y st Jia i ) cDGI paly) o g giad A gara
Clipboard
() Paragraph
() Font
() Editing

60. group commands enable you to modify and enhance the

appearance of your text. i
i) ) gedh Ceady Joanilly Al macd 45 gaa

() Clipboard

() Paragraph

(] __ Font

() Editing

61. group commands enable you to format complete paragraphs.
S BN JalS (el ll frand 45 pasa

() Clipboard |

() ___Paragraph

() Font

() Editing

3 grn L) Analp 4y jpaand plal -J 9V} (S5 £ M copy.com ASa (sl A phaa (Bgkal) gpan
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62. group commands enable you to apply pre-defined formatting to

text.

ol e Ayles Cilipaall (Bl Al fran 4 gara

() Clipboard
() Paragraph
() Font
() Styles
63.___ group commands help you to find and replace text as well as make

selection. _

siaa g LaS Galll Jlagdul y oyl B dielud 4 paza

() Clipboard
() Paragraph
() Font
() ___ Editing

64.Which of the following is correct.
a5 (A O )
() Cut -->Ctrl+X
() Copy --> Ctri+C
() Paste --> Ctrl+V

(] __All of these

65.The Cut icon is used to move a selection text to the clipboard.
Adlal) N ssaall et Sl padiey adll

() True
() False

66. The Clipboard Task Pane is used to view the contents of the clipboard.
dbilal) (s giae (ya ad padiy ABHAY 5 5

True

() False
3 e lal) dmaly 4y ppadan plal 0¥ (S 5 £ Mk cOpy.cOm 43S (520 Ak ghaa (Fskal) gaan
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67.The Paste icon is used to insert the latest copied or cut item from the clipboard
into the document.

Mngmaanc,.uai,wc..smﬂ@,wpxuﬂ&dﬁﬁ

() True
() False

68.The various Paste Options are:
A (all adbidal) <l juad)
1. Keep Source Formatting '
2. Merge Formatting
3. Keep Text Only

() __ True
() False

69.The Format Painter command is used to copy the formatting applied to a section
of text to another section of text.

sna el Akl (Bl pan (Bl i o

() True
() False

70. .txt is an extension for

d alaial ga txt
() M™MSWord -
(] Notepad

}  WordPad
)  None of these

(
(

71. A Font is a design for a set of characters.
GVl Gade yaaad pranal g4 dadll

True

() False
3 gnn ALl Aaaly &y jpudaand plal =S V1 (S5 £ cOPY.cOM 43S (gal 4B ghana (3 ghall agan
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72. icon is used to proportionately increase the size of selected text.
aaaall ail) paall duudiie 3oy padiey pal
() Shrink Font
() FontSize
() Font
( 1__Grow Font
73. icon is used to proportionately decrease the size of selected text.
a1all aill apall cudile Gkl piddy s
() Shrink Font
() FontSize
() Font
() GrowFont
74. Font Color is the text color.
walll Gl ga B3l Gl
() True
() False

75. The Bold icon is used to make text appear darker and thicker.

Basdl g 3ad) palll sl Jaal paddy FaE jal

() __ True
() False

76.The Italic icon is used to make the characters of selected text slant to the right.
Ml&ii&hi}i&diﬁJﬂM'ﬂuﬂdﬁhyi
True
() False

77. The Underline icon is used to draw a line above the text.
MHILBJ’“?MJ.M.‘ sl sl

() True
() False

3 gtns Alal) Ay 4y ppuiaaS plal I V) (4855 £ M copy.com 43S (g2l A5 ghaa (3§ ghall paan
©@ashraf 2017 16 0599814114 A5 1 galt i)l )

Scanned by CamScanner




S 0 0 g

.'”&’1&"‘&*—-@

B [l

=

Microsoft WORD 2016

78._ changes the selected text to small letters. .
ke o ) I sl galll js

[ ) lowercase

() Sentence Case
() Uppercase
() Toggle Case

icon is used to apply various effects to selected text.

79.

_ saadll paill e Ailia @l 50 (Gabil pad0uy )
() Font
() FontColor

() TextHighlight Color
[ ) Text Effects
80.Clear Format is used to clear or remove all the changes or formatting applied to

the selected text.
A palll o Al cliad) of G Al asan A35) o) grual piidey (Gaudll) fase

() True
() False
81. icon is used to draw a line through the middle of selected text to

indicate that it is cancelled out.
sAl) A dad daaad) el chualia (A b sl padiey )
() Underline _
() Text Highlight Color

{ ) Strikethrough

() TextEffects
icon is used to create small letters below the text baseline.

82.
oadll Jiul yhua oo sLAN aadiuy el

() Underline

() Subscript

() Strikethrough
() Superscript

dgnan el dnaly &y ypuaad pla) wdg¥) S 55 £ A cOpy.cOm 4iSe 52 L ghaa (3 ghall ppan
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83. _ icon is used to create small letters above the line of text.
ﬂl&l}mdﬁﬁ&?pﬂqx\

() Underline

() Subscript

() Strikethrough

[ ) Superscript

. There are four types of text Alignments: )
s e * oA oalll B3 e Bl 22 U

1. Left

2. Center
3. Right
4. Justify

True
() False _
85.You can use the horizontal Ruler just below the ribbon for indentation.
L) Abluall 332l Jay pil) i) Al A0 488Y) 5 placuall pladicad gkl Gl
Tru ' _
() False

86. The Line Spacing icon is used to change the spacing between lines of text or the
spacing before or after paragraphs.

Gl Sy 8 Alcal) gl gadll saul) (s ABlall A3l aadlen jhul) LS sl

l-‘
R

()
()

alse

i

87.Bullets and Numbering helps you to list any text in an ordered or unordered

form.
Lisa s o) Al e Aadll J83 b el 5] pudry (b il (ad 11 3laadlly Jall) 3lanl

() __ True
() False

3gnn ALal) dnaly 4y ppuiaa plal J Y1 (S5 € Ml copy.com 4iiSa sl i giaa (Gahall guay
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88. icon is used to apply background color to whole line of text.

)l a1 ol ol Bl prion ol

() _Shading

() FontColor
() TextHighlight Color
() TextEffects

89.The Paragraph Dialog Box is used to apply a combination of various paragr aph

formatting effects. '
Cllaadil) ) 5000 AiliSe 45 pagea (Baadill paddey B AL ) gall (3 gdia & se
(] True
() False

90. A Style is a set of formatting characteristics such as font name, size, color,

paragraph alignment, spacing, borders and shading.
seaall el 5al sidae ol aaadl dadll aud Se Gl Galliad e de gaze g Ll

Jallesh
() __ True
(). False

91. Editing group enables you to select, modify, replace or search text in your

document. :
Alaal) (B Gl gl Jlaia¥) | Gaadl) spadlly &) mand Juall ic gana
() True
() False

92.Find button enables you to search the text or a phrase in the whole document.
Mldﬂﬂiq‘uﬂm&acﬁh_’l‘ﬁi& Mﬂm&h—ﬁl el

() True
() False

d gtan L) Amaly 4 ppaas plal - Y1 S 5 & L copy.com 4iSa s 4B glaa (§ ghall faan
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93. tab enable you to insert things like Pictures, Clip Art, Shapes, SmartArt

Graphics, Charts etc.
, RS Clag )l | QLY AN clobialll | gl e sbdl gt A ey queS

- Al Sila gl
() File
() Home
(] Insert
() Page Layout
94. group of Insert Tab is used for inserting a cover page, new blank pages
and page break. .
GlY) O Jual gi)) | A2 Ji Ay Aadiall LS 1Y pARIud 713 el (A A5 gaa
() llustrations
() Pages
() Links
() Text
95. group of Insert Tab is used for inserting Picture, various shapes etc.
Y COW [RTPIRTWY (PO JRELIRF JRYPUVPY. P PEFVES:
() lllustrations -
() Pages
() Links
() Text

96. group of Insert Tab is used for Hyperlinking and Bookmarks.
Lo e Adie g i oyl ) E1 0N 285G 18 quuad (A 42 gana

() llustrations
() Pages

() Links

() Text

dgn Alal) Analy 4y ydant plat oJg¥1 S 5 B s cOpY.COM 4484 (52l ABgiaa (yiadl gpay
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97. ____ group of Insert Tab is used to insert Header &Footer and Page
Number. -
Claduall ol jlg Sy ul @IV pAR0T E1 sl (A A5 sa
() Hlustrations
() Pages
() Links
() Header & Footer
98. _ group of Insert Tab is used for inserting various text boxes, date &

time as well as word etc. or
Word wile e clglly gl | gai g e oY pa85uG Z1 30 sl (B 45 g2
Text
() Pages
() Links
() Header & Footer

99. group of Insert Tab is used for inserting various symbols and math

equations. ) _ o
dadaly ) c¥olaa g Allida jga) EIoY pa80 7Y s (A4S sada

() Text
Symbols
() Links

() Header & Footer

100. A Cover Page is very first page of any article or book etc.
Al g S (5 dadea J o A 098 dadial) LidE

‘ 2 True
() False

101. The Cover Page icon is used to insert a cover page at the beginning of the

document. i .
ATl 4404 A dadall NS 1Y padiey dadial) LDE al

() True
() False

__ 3 gt AL Anala &y ppudaad plal = IV (S5 B Mk cOPY.cOM 43%a (53 4L glaa (G ghall pian
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102. A Table contains data or information in the form of Rows and Columns.
Baas )y i ghua 8 CULy o (g 9 dgsd)
True
() False

103. When your cursor is within a table, two contextual tabs named Design and
Layout appear under the heading Table Tools.
J9aall o) gie Cant Baaill g paaalll pgsbanet Coulian (s 955 33 Jaaad) (B piigall (19S) L
True
() False

104. You cannot change the size of a table.

Jysadl paa S gl ¥ 4

() True
() _False

105. Combining two or more cells together into one cell is called merging cells.
l,_dﬂi@dﬂihb‘#@ﬂ@ﬂlﬁ@liw

() True
() False

106. Split Cells icon in Layout tab of table is used to combine two or more cells
together into one cell . '
Baaly ld (A Llny aa JS1 ) (il pand padlien Jeadl Buadll gl (A L) e
() True
(] __ False

107. A quick way of formatting a table automatically is to use the Table Styles
dstadl Bladl adlilaily AL JS& Jgaal) ) day pour 4y 5k

( )__True
() False

108. Border is the outlining of a table cells, rows or columns.

oY) o) i ghall o) Joaad) LOAT o Al SUSI A 3 gaal)

() True
() False

3 gs llal) daals & puiaad phal 19V (S5 £l cOpy.COM 4iSa (g 4B ghaa (3 ghal) aian
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109. You can create a table from existing text.

Pl gaill G Jsta $LEH ybied )

Tru
() False
110. icon is used to insert a picture in a document.
aiMleJ,‘.EiﬁYM}l
() ClipArt
() Shapes
() Picture

() Allofthese

111. You may apply various artistic effects to an inserted picture. _

da i sl o dibisa i 80 Gk gkl
() True
() False
112. You may crop a picture to remove unwanted parts or crop a picture into a

specific shape.

M JS& o Jgaall o puall (o lgsd il ja i) £l 5aY) el gl Ly
() True i
() False

113. Text wrapping makes it easy to wrap the text around a picture in different

ways.
dilisa ik o sall dea pall il Al g Jaag palll calidl)

() __ True

() False

114. icon is used to insert various readymade illustrations, audios and

videos offered by Microsoft.
b g g JSn 4S5 (9o Aathe g o) S gual gl B0 Aaa 5 Cila gau ) 1Y paian

() ClipArt
() Shapes
() Picture
() Allofthese

3 gps AL} Amaly &y punad plat = g¥1 S 55 £ L cOPY.COM AiiSa 5] ABghae G sdall gan
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115. _ icon is used to insert predefined shapes into your document.
Mlulo_;lladl&u' z) oY paidey 4l
() ClipArt
() _Shapes
() Picture
() Allof these

116. graphics are visual representations of information that

communicate your messages or ideas quickly and effectively.
ool ity o puay e 380 o A S g3 sl il glaall (i pa Jihald U-’""' e

() ClipArt
() Shapes
() Picture

()] SmartArt
is a visual representations of data and conveys information in an

117.
easy to understand and attractive manner.

A gy gl U ggod Silaglaal) Jygady CUL (Hpa JiS

() ClipArt
(] Chart
() Shapes
() Picture
118. There are many types of charts like bar chart, column chart, pie chart, line
chart etc.
Bl adlly g il g Baas ¥l Jia Adall ila g £ 91 Ga ad) SA
True
() False

119. group consists of commands that enable you to create Bookmarks,

Links and Cross References
L daal gl g A sal) Cladledt LAY Ul mand jalg) o Crasali A5 pana

() lllustrations

() Links

() Text
() Editing

J g L) Amaly 4y patiald plal = g¥1 S5 B LS cOpY.COM 4584 (g2 A8 glaa 5 ghall
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120. Hyperlinking is a process to link some content or text to a webpage or place

in the same document or to another file or document. i
Gile 3 ) ) Sl e ) a0 plgae B gl ) g giaall g By Tl ) Jagl
‘ Allaual) B A1

() True
() False
121. on hyperlinked text and select Remove Hyperlink
_ (il o)) faa JdS g mtS) B e
() Left Click

() Right Click

() Double Click
() Allofthese

122. Bookmark is used to move or jump to a specific location in the document

instead of scrolling through many pages.

Q.J;ﬂ_,g,.nruﬂ;,..,_mMrgmwﬂﬁs,mmgﬁm@ﬁiwi
Slad.all

[2 True

() False
123. The text, symbol, picture, page number, or anything that appears on the

bottom of every page of the document is called as .
(ny ATaall A Sladiall Jhaal A gy b o) ) Chadeall g1, geall | sl el

() Header
() Bookmark

() Footer

() Hyperlink

124. The Page Number icon is used to insert the page number on every page of

your document.
B! A Cladiall J$ Jo Sladiall o)) 1,8 padied cladeall o ) 45k

()] True

() False
3 gt L) Analp 4y pudand plal oI 91 (S5 S cOpy.cOM 438a (530 45 gla (§ ghal) ggaa
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125. The WordArt is used to enhance the appearance of text.

oaill jglia Cuail sriduw WordArt

() True
() False

126. The Drop Cap is used to enlarge the first character at the beginning of a

paragraph. ) .
B Adl) Ql#@dﬁd_’lﬁﬁlr“%‘ﬂﬂ}?‘
True
() False

127 tab is used to change the document orientation, page size,

margins, indentation, line spacing and paragraph settings.
¥l oL Lald) Alall | (Sal ggd) dadiall paay , dliasall olad) padl pdddey et gl
oAkl Calae )y

() File
() Home
() Insert

{]___Page Layout

128. Margins are the small area around the text.

calll a0 staa dabuca (35S (sl ggd)

() True
() False

129. There are four margins: Left, Right, Top and Bottom.
Jhaly o)l Cuag el b g ) Hlin

() True
() False

130. Orientation is the direction of page.
daiiall olad) gn dun g3l

True
() False
3 g L) daaly &y ppaad plal g1 (S 5 £ L cOpy.cOm Li%a (s2) A ghae (3 ghal) aan
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131. There are two orientations: Portrait and Landscape.
(Ally gagals dadall cpatad) s
() __ True
() False

132. The Hyphenation feature is used to split long words at the end of line. )
Mlgmgwlmiﬁ.ﬂ,mmm

{) True
() False

133. Watermarking is a process of adding see through text or images to the

background of a document.
les_)y#_" (.1:'.)‘ u.u;.sL.aYi._aL: L.f‘ i.;.’:L.]IL)L-JI

() True
() False

134. You can change the background of your document to a Gradient, Texture,
Pattern or Picture.

peally JsLai¥y pualally gzt 1 aianall Ailis a5 gl i

0l True

() False .
135. The tab commands help researchers & professionals in creating

references in the document.
_M&’_}e;&!"h MIJ@QIQ&J&HL}.& _}a’l_,l.‘c.hﬁ

() TIhe References

() The insert

() The view

() The page layout

136. A Table of Contents displays the topics of the whole document in a list
format and facilitates easy location of topics.

e guin gall (fSa () pum sl gy g Al S5 (g8 ALy il e guda g iy sinall Jaa G pmg
il sinall i a5 LIS L o g 14,

() True
() False

3 g Alal) daaly 4 padans plal mﬂi@j&}dmpy_wmm A A8 ghaa jsdal) VLN
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137. The Update Table command, available in the Table of Contents group, helps
YOu to update the table if there are any changes in the titles or page numbers.

sl lia S 130 o yaall Cyaat e il siadl Jgan e yana (i35 sal) J il Cuaat a1 ey
Sladeall Q1 5 oy glinll A Sl a5

() True
() False

138. The Footnotes group helps you to insert additional notes about
words/phrases either at the end of each page or at the end of the document.
il dglgs A ol Aaiia

“ True
() False

139. Footnotes appear at the top of a page and are a way of citing source of
references within the text of a document.
Aiiaall i (B gal yall jaand] s L Al y o4 dadeall Jind Gl L3 el jedas
() True

() False

140. tab helps you to check spelling and grammar mistakes, count words,

translate and change language.
Anlll a5 gdaa i : SLalSh aae Slall j.,.:.:.l,i]bi.,é)\..‘!l eladly! u-a;.ll.\c..l..g TP

() __Review
() Home
() Insert

() References

141. The Proofing Group contains proofing commands for spelling and gamma

correction, research, word count etc.
) SlalSl aae g Gaglly ool gl g BlaY) FAN saly) o (g giad SV e gaga

() True
() False

5 A gmas Blall dnaly 4y ppaad plal oW1 (S )5 £ L copy.com 4siSa (538 4B phae (Fshall pjap
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142. In MS Word 2016 spelling errors are represented by wavy underlines..
LA Jhat pata e daal g (fida S (S Ladl MS Word 2016 o
) Red
() Green
() Blue
() Black
143. In MS Word 2016 grammatical errors are represented by wavy
underlines. _
Al Jial g e i ) gy Jidia (S oo 4l Uil MS Word 2016
() Red
(J_ Green
() Blue
() Black
144. In MS Word 2016 contextual errors are represented by wavy
underlines.
Al Jiul 7 e i Aol g (Jiaia ¢y gSur (Sl Usddl MS Word 2016
() Red
() Green
() Blue
() Black
145. tab allows you to view a document in different ways.
dinsa b A Al ga al ol ey Gy gl
() Review
() Home
( ) View

() References
146. The Print Layout displays the document as it will appear on the papers after

printing.
Aokl ol 43,11 o ek LaS aliall (2 a5 delhall (i e 44y 5k

(1 __True
() False

3 g m;i..qi,_,m,u =J ¥ éﬁtﬂcopy,comlﬁhgﬂiﬁ,ﬁndﬂdlm
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147. The view is the default view when you create a new document.
This view is often used to work with standard documents, such as letters,
brochures, reports, etc.

P80 L 158K (i alne L] e Agual EYI ia yall 4y ol A vaall 4k
Ol 1) Ly ¢ ]y g€y il 1) (Bin cigulil) il g Janll 020y ol 4y ke

Print Layout
Web Layout

Read Mode
Outline

[ e

148. The view to create and edit pages that you intend to publish

online.
i Y e eyl g 40 Al Sladaall Ty sLESY Laall Ak aladiul dliSay

() Print Layout

( [ Web Layout
Read Mode

()
() Outline

149. The allows you to create an outline of a document and shows the
content as a bulleted list.

Aok 4S5 ginall ey atiaal aladia oL Ll Jalada "y jall A0y )k dll 2
() Print Layout
() Web Layout
() Read Mode

tli

150. By using the Outline tools, you can move your text up and down, expand and
collapse levels, change heading levels, or show only one kind of heading level.
g ol Lenaal g iy ginsal) g g5 o Jiad g oY (aill Ji dli€ae umih Jadadall il gof alasily

Oyl (5 e e Jah 2l g & 45 g pe 5l G gliall iy giana

{) True
() False

gt dlal) daaly &y i plal (¥ (4S5 £ MG cOPY.COM 4380 (2] A ghae (3 skall aian
®©ashraf 2017 30 0599814114 A5, el iy

Scanned by CamScanner



‘Microsoft WORD 2016

151. The____ isdesigned to edit and format text quickly. This view is useful
when you have to focus on the content, rather than the printed output.
dhle (yy Lavic e (i pall 138 ey 4z el a8 ia el 3yl poass o5
£l AT a Ty s sl o S

() Draft view :
() Web Layout
() Read Mode
() Outline

152. Some page elements such as, the boundaries between pages, headers and

footers, backgrounds, etc. do not appear in the Print Layout view.
.ﬂlbujj Loy claalslly tﬁ:ﬁﬂmbw_,_',)]‘_,ubwloﬂd_pﬂ\ tfie dadall )alj; ey _)g.LﬂY
el Lgdai (s e sk 8

() True
() False

153. You cannot hide the Ruler in a document.

Aiuall A o hual) pUA| auhiindy @il

() True
() __False

154. PDF is a short name for Portable Document Format.
JAl G Clabiuadl agall JLald) sAPDF

() True
() False

155. You can save a word documeht in PDF forrna_t.
PDF 4ima 2 Word i Bia askaiod cui)

() _True
() False

156. A template is a pre-designed or preset formatted document.
" Aliceall AL (Baaall o) (Gaasa pranal gh Gulldll

( L_True
() False

3 0 L) dnalp & ppaal plal =J¥1 (S5 £ S cOpyY.cOm 4yiSa (51 A giaa 3 hall paay
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157. You cannot save a word document as a Template. .
<l \S Word Alieee Bia aiaiod Y Sl

() True
() _False

158. The file extension of Word Template is .dotx . )
dotx (138 Word wila Gl afaia)

True
() False

159. The default file extension of word file is .docx .
.docx ssWord wilal el a8V 318y

() __ True
() False

3 gpn Alal) dnaly 4 paians plal ad ¥} (S5 s cOpY.COM 4Sa (sl Al ghae (3 ghall ppay
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1. ASpreadsheet is an application program used to organize and store dataina

tabular form. It consists of rows and columns. -
Cigiea (e clliyy Jyoa JSA e L 35y i) il a5 gl prali 2 9o UGl J g3

si.‘u:-‘_g

{ )True
( )False

2. Features of spreadsheet programs
il J g zal_n Gl e

( ) Fast and effective data comparisons
( ) Automated calculations and AutoFill
( ) Functions and Formulas

( ) All of above

3. Which of the following is an example of Spreadsheet.
| g SN Jhaadl Lo Qe N (e )
( ) Corel Quattro Pro
( ) Apple iWork Numbers
( ) Microsoft Excel

{ ) All of these

4. Microsoft Excel 2016 is an application software and is used to carry out
calculations like Corporate Budgeting, Inventory Management and to plot
graphs.
3l |ds)ﬂlzesl_;3.&1ﬂm1a@AlMMJU@@ujzolledyﬂs,u
Al e g M1y | 50530
( JTrue

( )False
5. To start MS Excel 2016 click Start Button --> -—> Microsoft Excel 2016

2016 oS! i gy Siha < mmm o134 el 2016 oSl i gy Sika )

( )True
( )False

_ dgnan dllall dnaly &y ppand plaf (V) S 5 £k cOpY.COM A4S (sl 4B glaa (Fghall gpap
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6. Tell Me Box: This box, located to the right of the ribbon tabs, allows quick access
to Excel commands and features you want to use.

1y 51 el gy L™ o 520 s ) e (sl gl 10 258 ol g
Lgalaninl 3y i Al 431 e Jusk! ol

True
( )False

7. The worksheet is the area which you will work in. B
JL._:J:- da.l:l‘,;.ﬂ’l ulS.A]l d-u-“u_)_,

( )True
( )False

8. A worksheet is divided into rows and columns.
Smbt_‘l_,i..au.nm&lj'lai_u

{ )True
( )False

9. The intersection of a row and a column is called a

A .1_,4‘.;.“_, Caall cLLi:
( )Field . :
( JName Box

Cell
( )Cell Address

10. is recognized by its black outline and data is always entered into

this.
L‘.l';h.ll.u'.'l C:L‘lg:\n_, .\J.u'l JLLJ :\.I:Lu‘_,._l%}.n
( )Cell
{_JActive Cell
{ )Column
( JRow
3 g L) Aaaly 4 ppinas plal J Y1 (S 55 £ AL cOpy.cOm Ay (sal 4B ghae Fglad) pran
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11. The is located to the left of the formula bar and displays the cell
address of the active cell.
adaall 40aN 3 Gl o) yie (e ey Adladd) day 5l e (e 25350 005
- [_JName Box ) . '
( )Column
( JRibbon

( )Workbook

12. is a horizontal bar at the bottom of the screen and displays
information about the workbook you are editing. _
adle S g3l Caiaall Jgn Cila glaall (s e LU Jinad (B A8Y) Jy p20) 0

([ )Status Bar
( JTaskbar

( )Sheet Tabs
( )Scroll Bars

13. is the real time-saver, which helps you to instantly create charts,
apply conditional formatting, table styles and quickly calculate data.

Ghanaiill (Bl ¢ il o Al o ey L2 e e lud G gl i ga (A o pud) il 3l
AUl s Ae a0 Dlilad (J saadl Lalail s‘.’.h_)a.ﬂ‘
( )Quick Analysis Tool ' -
{ )Smart Lookup
( )New Chart types
( ) Quick Analysis tool

14.The shortcut for Quick Analysis Tool is
5o Calall 3l latal
CTRL+T
CTRL+Q
CTRL+A
CTRL+P

15. To create a new workbook click on File --> New -->Blank Workbook --> Create.
sl o e Clas <——-dda < cila e laal) dna Clliag (LAY

{_)True
( )False

A g lal) daaly 4y ppudand plal Jo¥1 (S5 £ & copy.com &S 5l Al ghaa (fghall e
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16. _____ isa pre-designed document created for common purposes such as a
budget, inventory list or planner.
Lt i adl sl Jia 4y e Y ¢ s paraa Sinsa
( )Workbook '
( )Worksheet

( JTemplate
( )AIl of these

17. You can use arrow keys (Left, Right, Up and Down) to move between cells in a
worksheet. _ |
Janll 43, :~_9'q Lo o JuEny ((.1‘--'" , o) b ,o:ug) C__u'h.ajl H.m‘ plasiul c._thi..ﬁ

( JTrue
( )False

18.You can use the key to move to column A.
A 3palall I JEEN Uik plasin aplaind il
Home
( )Ctrl + Home
( )Ctrl + End
( )End

19. You can use to go to the beginning of the worksheet i.e to cell Al.
Al sl s Jaadl 45,y Loy I Jassd CL'xi‘ PRESW t_;.k:...ﬁ il

( )JHome

(_JCtrl + Home
( )Ctrl + End

( )JEnd

20.You can use to go to the last cell in the worksheet that contains data.
il o (g gind Jaadl Ay A4l A I Jas zlia pladinl ankaiug il

( )JHome
( )Ctrl + Home
{ JCtrl + End
( JEnd
3 g Sal) Anala & ppuinnd plal gV (S5 £ M cOPY.COM 4iSa sl 4B ghaa (3 ghall gyan
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21. You can delete, overwrite or edit the contents of a cell in a worksheet.

Jaall @y A la)) (5 sina o Jandll f LS) Bole) jcaia aglaind il

[ )True
( )Faise . _ .
22. You can also use the Formula Bar to enter and edit data,instead of editing

directly in the cell. ) o o
a0 e alal) Jasaill (e Jay Gl Jaady JEY Aolaal) day i pladiud ashaud i

True

( )False

23.By default a workbdok contains worksheets. ) o
(_1&9;5_)) d:g_,bgu@‘ﬂ*wlﬂ?l@#‘

24.To insert a new worksheet click on Home Tab --> Cells Group -->Insert --> Insert

Sheet.
19 oo g1l <o LA e yana <--Homie s (e bl sapa Jae &, 21 ,0Y
. Jac 43,

True
( JFalse

25.To delete a worksheet, click on sheet tab --> Home Tab --> Cells Group --> Delete

--> Delete Sheet.
)y Cila €ommmm Cila €ome LAY de yana <—-Home S o Jaiual sia Jac 3 )y Cidal
Jas
True
( )False

26. Press to insert a new worksheet.
s Jao 48 )y 21 0¥ e kil
( )Ctrl + F11
{ )shift + F11
( JF11
( JAlt +F11

donas L)) dnaly & ppuiaa plal gV (S 55 B i cOPY.COM 44iSa 9] Al ghaa (§ ghal) ppan
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32. The function provides a quick way to sum columns or rows of
numbers in an Excel worksheet.

29. You cannot move or copy a worksheet within a workbook or to another

{ }True
( )False

30. To change the sheet tab color Right Click the Sheet Tab and select Tab Color.

[ JTrue
( JFalse

31.A Function is a prewritten formula that performs calculations automatically.

{ ] True

27.To rename a worksheet Right Click on the sheet tab and select Rename.
pued ) s ALy Jaad) 485y Gy 9 e pandl 3 )y dakaial Jae Ay a2l
[ MTrue

( JFalse

28. You can rename the worksheet by double clicking the sheet tab.
Jandl 48 5y 95 Jle (5 e Jaiadally Janl 48 5 5 Dpand Bole | SliSay

{ JTrue
( )False

workbook.
}|MQ'J‘M‘JM&M‘EJJ&AJI&W?&!

sl 08 SRy Jandl 48y Cu g e Gaa¥l 5N )y dadal Jaal 4y o jandd

LS llaa o13Y 0 jAls Ay 30 Aikas Alal)

False

(] __Sum
() Average
() Max
() Min
dgpae Alall dnaly 4y ppuiand plal Jg¥1 S5 £ L copy.com 458a (g2l Al gias (§glal) gran
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33. To select Sum function click on icon in Function Library Group of

Formulas Tab.

(] ___Math & Trig

() Logical
() Financial
() Statistical

function can be used to find the average of a list of numbers.

34.The
PELY (e A Janall Slas¥ Lgaladinl aglaing Al
() Sum
{) _ Average
() Max
() Min
function

35.The Average function is a

Ay 5688 Jaaall ally

() Math & Trig
() Logical

() Financial
(] Statistical

function counts the number of cells in a range that contain

36.The
numbers.
) e (5583 3 LAY dae iy

() Sum
() Average
() Max
() Count

d e L) daaly 4 ppuian plaf o} g¥) S5 g copy.com 4ise gl 4B ghae (35l agay
©ashraf 2017 39 0599814114 &5 uid) |

Scanned by CamScanner



[ —
&&= Microsoft Excel 2016

37.The _______ counts the number of cells in a range that are not empty.

e il DAY e il =

() COUNT

() __COUNTA

() MAX

() MIN

38.COUNTA is a function.
> ,» COUNTA

() Financial

() Logical
() Text
(] Statistical

39. The function is used to find the largest or maximum number in a given

list of values.
lanall 2l 4 ) e ) S alag¥ aadis Alls
() Sum .
() Count
(] Max
() Min

40.The function is used to find the smallest or minimum number in a

given list of values.
‘J'L.‘]lfﬁi”(.“i ‘.S__“_]SI _,' _)'l..a'l J‘ﬁy ll-\h-h-ll-l-. ‘;-“.‘n

() Sum
() Count
() Max
(] Min
3 ghn Ll dnaly 4y ppuina plal Jg¥) S5 A& copy.com 4uisa sl A giaa (fshad) gyap
©ashraf 2017 40 0599814114 (Ll oy |
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41.The ______ function returns one value if a specified condition evaluates to

True or another value if it evaluates to False. )
s j@mhigﬁwkﬁwmljw&jdu _

() _IF

() Sum
() Count
() SUMIF

42.Conditional Formatting options allow you to apply different formatting options
such as background color, borders or font formatting to data that meets certain

conditions.
Clilall aalh 03 4 3paad) Lalall ) i dilise i Gadad ol prand Ja g plal) Sauaill S A
Jay 52l Gind
() Twe
() False
43.The icon enables you to quickly format a range of cells and

convert them into a table.
It ol Ledipady LA i 5y g geall Bl el ransns ) sl

() Table
() Conditional Formatting
()] Formatas Table
() Allof these
44.The icon is used to quickly format a cell by choosing from the pre-

defined styles.
o alall LLa¥l a il assf g LAY oy paad) (Ganiil] paiiuds 4 gi)

()  Shading
()  Cell Styles
() Page Color
()  Format Cells
3 gnas Ll daala 4 ppnal plal S o¥1 (853 £ & copy.com 48a s 4B ghaa (3 ghall ayan
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45. group commands help you to find, replace, sort and filter data as

well as clear data and formatting.

gonnady il giady o il Jlaiaaly Cndh Blae b dhacld t_:j;y _,d::j:
() Font
() Clipboard
() Styles
() Editing

46.You can sort data by text (Ato Zor Zto A) and numbers (smallest to largest or
largest to smallest).

( sV A SV (e 5l HSY) I el e ) a Y1y AZ (e bl s 5 absins il
(J True
() False

47.The Sort & Filter icon is also used to filter data as required.
allall s Agheail 233505 dduadll 5 a5 ) Lyl

Ll Irwe
() False

48. At Home Tab icon contains options which can be used to find
specific data, select the related cells and also replace data.

Ada)) lsaly sanae il slagY padiud ol i e (g giad Ll HOME s 4
il Jlagia) 54y glkaall

()  Sort&Filter

(] FEind & Select
() Insert
() Format

3 g Al daaly 4 ppuiand plat J8¥1 S5 £ L copy.com 408 (sl 4B ghaa Fgiad) gpan
®©ashraf 2017 42 0599814114 (A9l iy |

T T

Scanned by CamScanner



Microsoft Excel 2016

49.Find and Replace is used to search some text in the worksheet and replace it by

some other text. i g
)iludﬂL‘JhﬁuUM‘ﬁJJq!un)mﬂumunmmemdm }_u-l'!

() True
() False
50.You may click to replace all occurrences of the search text by
the specified new text. o
m@@@@@l@l%iwdi@‘f e Janai il
() Replace

(] Replace All
() Replace With

()  Find and Replace

51.The group contains the available number formats in Excel. )
JuSYI 8 A8 ,00 dilise sl )i 53 (o (g5 9ia3 dc gana
() Font
() Alignment
()] Number
£ ) Cells
52. format is used for general monetary values' and displays the default

currency symbol with numbers.
g}lely|ﬁy1Ml}jL@ﬂJs_M ‘;.‘La.lm"_‘.’em.l"

() Number
() General
{) Currency
()  Custom

3 grn ALl dnaly & jpdaad plal gV (S5 £ LS cOpy.cOm 4iSa (i AL ghaa (3 ghal) IVEN
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53. Home Tab is divided into groups. )
()4
()5
()6
()7
54, group contains the main editing commands such as Cut, Copy and
Paste :

Cualy ad g gani Jin Aand Il el g¥1 (o (5 935 ic gara
( JFont Group )
{_)Clipboard Group

( )Cells Group
( JNumber Group

55. is used to change the background of a cell.
LSal Zdlall o il paiid
( )JHome Tab
( JFont Color
{_JFill Color

( )Borders

56. This group commands enable you to position data within cells as required
walhe 9o LS L J&\.:leciy_»iﬂeuc..uﬂh}&;d1nh
( JFont
{_JAlignment
( )Number
( )Editing

57. The Top Align, Middle Align and Bottom Align icons are used to specify
alignment of cell data

el Jals cill o Maall yaatl paatid Jiwd y dana gl y e S ol 3l 4 4
( )Vertical
( )Horizontal
( )Diagonal

( )yone of these

©ashraf 2017
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58. icon is used to display the text in a cell in multiple line
padmie LA i paill (el padies A
A ]Wrap Text
( )Column
( )Merge & Center
( )insert
59.The icon is used to join selected cells into a large cell and centers

the contents in the new cell
a3 a8 el (g giaall a3 S AL sddadl LAY paad p04505 45 43
{ )Merge & Center
( )Merge Cells
( )Merge Across
( )All of these

60. The icon in Cells Group of Home Tab is used to insert additional
columns, rows, cells and sheets

(_Jinsert

( )Delete
( )JFormat
( )None of these

61.To delete multiple rows, select the rows to delete then click

Home Tab —> Cells Group —> Delete —-> Delete Sheet Row
- il € LA Ao e <= HOME s il & (Gay shudl 3aa | gl sae (adal
dau.“ 23_)_, QA (Lo (Bl <

{ )True
( )False
62.The Sum or AutoSum icon is used to calculate sum of the selected cells

saaaall LAY manll llual paatiad AN paadl 5} paall 4 4y

True

( )False
3 g Alal) dnaly &y ppaad plat Y1 (S 5 £ S cOpY.cOM A38a (2] Al ghan §hall pyay
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63.A_____ isan expression that performs calculations on data contained in a
worksheet. :
Jandl 4y b LAl uluall Slglanll el 2ls o sl 25 A
( )Auto Fill
( JFormat Cells
[ JFormula

( )None of these

64. A formula uses arithmetic operators like +, -, *, % and * to perform addition,
subtraction, multiplication, division, percent and exponentiation respectively
L._.ihn_,mu ‘_;Tn')..iall_,c_)]n]l_, 'c.n:_dl a‘ﬁYAJ% '* -t :L_uLun..“ lepmulu]

oYy Apaail

[ True
( )False

65.In Excel a formula always begins with an equal to sign (=).
= 5_LaL lad Laily JuSYl &Y laa A

{ )True
( )False

66. You can use the Decrease Decimal icon in Number Group from Home Tab to
reduce the number of decimal places.
2yl Jal il L HOME 2585 00 pY1 e gana (p0 4 pdiall Jual sil) 5 gyl i)
1,3
P

Tru
( JFalse

67. You may use the keyboard shortcut Ctrl + ~ to quickly switch between the
display of formulas and their results.
2l g Y sled) a e (o il g e IS Crtl + ~ giliall da ) jLaial pladiul aabiud ol
(_True

( )False
3 g ALl i.ul.)wfh'l =¥ &jwmpy.mm:\,\& a.ﬂuﬁudﬁmﬂ L IVEN
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68:. __ _ errorindicates that one or more cells that are included inan

arithmetic formula contain text. -
umujcq)m&lﬂ‘qﬂwlb}a]lwﬁijlhb_ﬁm Uasll

( )#DIV/0!
( JHREF!
(_J#VALUE!

( J¥NAME?

69.____ errorindicates that a number is divided either by zero(0) or by a cell

that contains no value.
‘y‘«.-la_,lFujcuwdahdlqswlhmw)ﬂ_,iubjm el

Sy e g sias
( )#DIvV/0!
( )#REF!
( J#VALUE!
( JHNAME?
70. error indicates that cells may have been deleted that were referred to

by other formulas.
Alslaall 45,Sall i Ly y WA Gl Uaall

(_J¥REF!

( J#NULL!
( s

71.This error indicates that a function is trying to do a mathematical operation on
text, or is referring to a cell that does not exist.

Sasmse o ) 30 gl el gl Aptua Alee Jee J a3 A Gl ey Unil
#NAME?

( J#REF!
( )#NULL!
( Vi

4 g ALY Analy A puians plal =981 S 5 £ M5 copy.com 4iSa g3l A giaa Fshall gray
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72.This error indicates that the result of a formula might produce a number that is
too large or too small to be represented in Excel
Q) i Aliaa lan s 5l lan S ) Cy pum Ly Al il (ol ey Uns
( JHREF!
( JENULL!
( )eada

( JENUM!

73.This error indicates that Excel cannot determine which cell is being referred to.
Agna yal) 4080 a3 ey Y JuSH gy pdy Uadl)
( )-HREF!
( J-#NULL!
( )-#NUM!
( )-Hushy

74. error indicates that the column is not wide enough to display the
content '
5 sinall iajad Y 3 galall Gy s Unill
(), #REF! )
(), #NULL!
( ), #NUM!

[ ), ##shn

75.You can copy a formula from one cell to another cell.

oA Ak e sl Fs aghaio il
() True
() False

76.The commands of this group enable you to insert various types of pictures,
shapes and graphics.
th)l‘}&?‘_’_},‘n wl&htl,&lclﬁ‘i&c_‘uﬁt)@l XYY é}‘}?‘

() Tables
() llustrations
() Charts .
() Text

-

3 g lal) Analpy 4y ppudaad plal ~J9¥1 (S5 £ M copy.com 4k (sal Alighas (@ ghad) ey
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77. The icon is used to insert a picture in your worksheet
AP RTEPRN I ST N B e —
(] Picture
() ClipArt
() Shapes
()  SmartArt

78.When you insert a picture or select an already inserted picture in a worksheet, a
new contextual Format tab appears.

Mu‘*‘!%qﬂéﬁ‘@!)ﬁdedd‘ﬁjjqjiJH@mJ‘s)McIﬁl-\:“'
Tru
( )False

79. A Chart is a visual representation of data and conveys the information in an easy
to understand and attractive manner.

MJ@MMQ&M!@;&,M@}JMJAQJ@HHJI

() True
() False

80. shows the title of the chart.
il Sl ol sl s
() ChartTitle
() Primary Vertical Axis Title
() Primary Horizontal Axis Title
() Legend

81. The area on which the data is plotted in a chart is called as __

it il a8 A dalaal)

() Legend
() _ PlotArea
() ChartArea
()  ChartTitle
3 gaan LAl Al 4y pdaaS plat g (85 £ I copy.com A4ise (sal A gha (3 skall pyan
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82.The entire area on which the chart is drawn is called as
s ) 3 e gyl AL Aalsall

() Legend
() Plot Area

() ChartArea

() ChartTitle

83.You cannot move a chart to a new worksheet.

Sjghdacujjuﬂqawlfu)l@@l:ﬁ.ﬁvu:ui

() True
() False

84.You can apply different Styles to a chart

)l e dilide Jalail (Bl alaiod il
() True
() False

85.The commands of this group enable yo&j to insert text boxes, headers, footers
and embedded objects. :

M@JwiJJuaic|Jigcﬂ]cAuﬁ:\syiahQj__)a'l_,\}'l

() Tables
() Illustrations

() Charts

Text
86. The icon is used to insert Text Boxes in your workbook.

() Picture

() WordArt

() Object

{1l Text Box

3 gpe L) dnalyy 4y jpaans plal =¥ (S 5 £ LS cOpy.com 458a (g4l Ak ghaa (3 ghall aran
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87.Headers and Footers are displayed on the worksheet in _ view '
e o ded Ay Az dadiall Ji3iy il

() Normal

) Page Layout
() Page Break Preview
() Full Screen

88. The Page Layout Tab allows you to customize the way your worksheet is set up.
Janll ;.5_)‘,]%4 Silalac | dﬂdd.]w;a&mn Liglea s

() True
() False
89. tab helps you to change the themes, page size, margins, print area

and many other options.
L}n_gﬁﬂ'_:ic-wl :LaL.u_,u:ng.“JiAiun.“ AR 9 Ciliaiill _)g.lﬂlﬂ.t:-l.n:_u_u’_,j

Salalae Yl
() File
() Home
() Insert
(] Page Layout

90. uses different combination of font styles, coler schemes and
graphical effects.

Ana gl 2l 800y s il g ol g dalaiU diliae Cilalae ] padiu

() Charts
() Themes

() Font Face
()  Shape Effects

91. By default, MS Excel prints worksheets in Portrait orientation.

$39ele oladl i danll T8 3 by JuSYI ol 81 JS2y

() True
() False
3 gtan lal] Lol 4y jpand plal o] 0¥ S5 £ LS copy.com 4iiSa 52 4B glaa Felad) gpan
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92. The icon is used to specify the rows and columns to be printed at
the top of each page.
daiiall el 4 delhll o gale e Sy e e Syl pndid
() PrintArea .

) Print Titles
() Print
()  Allof these

93. The Spelling icon is used to check the spellings in your workbook.
Janll 45 5 3 Ok oLlaAY (pa 2SN a3usy (DM G

() True
() False
94. key is the shortcut for Spell check.
Y Bl jlaial o8 Lk
() F5
() F3
(7
() F10

95, The Split icon is used to split the worksheet window into separate panes.
dabia g p\ﬁ‘u.“dna.nqj_)_,a;\ﬂ.lrﬂd‘ v ‘péa.luu" "..z..m_ -'i.'l_,igll

(] True

() False
96.The icon is used to keep a portion of the sheet visible while the rest

of the sheet scrolls.
Janll 485y 6 JE5 Ly (5 5a Jaall 85 (1 ¢ jo Jaiad 00205 a5 ay

() Split

() Freeze Panes

() New Window

()  Scroll Bars

97.Whét is the extension of excel file
JusSY Cala Jiie g8 Lo

() .PPtx
(] Xisx
() Axt
() .docs
dgna AL dnaly 4y puaal plal =Jg¥1 (S 5 £ LS copy.com &S sal 4B ghas akad) ayap
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1. Microsoft PowerPoint is a program that comprises of text, 3D

graphics, audio clips, sound effects and flashy animations.
C‘LG‘J‘3D‘-“—'L-_,M_)_’, ‘wﬂlw@ujﬁmlﬁjﬁ&y”sy@uﬁ
AS jaidll ‘._}u_)"_,l;t_’u:" Cal_):_'yn.“-, u;l_,..a.“

() Images

() video

() documents
() none of these

2. Presentation graphics software is an excellent tool to communicate a message
and to persuade people.
oetill &L'élJKIL.._)JI Juail y Jual 51l 5 haa Sl 43l daatill oy jall c.al.:_).z
() True
() False

3. In Graphics Presentation programs each presentation is divided into
oAl s i m e S Lpa gua )l g yall rali g

() Slides
() tables
() pictures
() charts

4, is a single page of a presentation, created with the Presentation

Graphics application.
a1 i jall e g (Bl ) g2 25l ¢ pag Bl (m jall (e B3 g A g my 20
() Slide
() Placeholders
()  Objects
() Animations
5 are dotted boxes in a slide, which are used to add Text, Pictures,

Charts, Tables and other objects.
-LS_P.J LS g o Jglany «lbahia g jpay ‘whuyﬂ@ﬁ@%am}@
() Slide
() Placeholders

() Objects
() Animations

3 g A} Aaalay 4y jaand plal = gV S5 P L copy.com A58 g4l AR ghaa Ahal) gyan
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6. are elements of a slide such as Text boxes, Pictures, Tables, Charts,

SmartArts, etc.
.Q-‘!SmartArts L | sQU:LT-..J'u_, cd_,'l..\:_h..“J iJ_’AdH_, l.u-:uh L.'_DLI._J_)‘: hﬁni.‘qﬁ JMLI“— L.f‘

Slide
Placehaolders

(
(
() Objects
(

) Animations

7. are aset of visual effects that can be applied to objects, so that it will

animate during the Slide Show.
Uae Da dl jaTilglaas Jalld (i€ e Lkl (S 0 45 Sl e de gana A

3,
() Slide
() Placeholders
() Objects
() Animations
8. are visual effects applied to the slides, when moving from one slide to
another.
A Gl A5 G JEY) i il 2 o BSR4 ja il
() Slide

() Placeholders

() Transitions
() Animations

9.1t appears on the left side of the PowerPoint 2016 window. In the Slide
Thumbnails pane, you can rearrange, delete, hide, duplicate and add new slides
in the presentation.

sale " 5 jiadll ) peall "Aay 36 ja A liSayy ¢ 2016 Ciia gy 5 53U e JanY ilal) ey day
il o pall ) L ilcal g dla ) S5 g clelia) y cledda g Bajaa il y0 s 5
) Slide Thumbnails Pane

Slide Area
Notes Pane
Status Bar

—— — —
L

; 3 gne ALt} dualy 4y ppaiand plal (I ¥1 (85 B Ak cOpY.cOM 4y (538 Ah ghae (G gdad) gpan
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10.  Itis the actual slide where you can add objects such as Text, Pictures, Table,

Charts, Video, etc.
edlia y cctilladadially ¢ J glanlly ¢y guall ld‘,}ﬂnig‘j‘aﬁiﬁiﬁu}d&%ﬁ?wﬂé&)ﬂ‘w‘
2 sl
() Slide Thumbnails Pane
() Slide Area
() Notes Pane

() Status Bar

11. It is located below the Slide Area, which enables you to add notes for each
slide. These notes are also known as Speaker Notes that the presenter can refer
to while delivering the presentation.

Wil cildanlall 53 G yay cday 3 JS Cillan e dla) (pa i€y Cua day pA0 Aaliss il 22 g
wgsdiill i jall il oL asiall Lgll pady Al Caratiall CillasSlay

() Slide Thumbnails Pane
() Slide Area

() NotesPane
() Status Bar

12. It is a strip at the bottom that displays active slide number and contains the
zoom buttons and the View buttons.

ol 15l sl €S 15l e (g ging g Aaill Aag B a8 ) (i yer JELY g3 3 g ga day 3 g0
() Slide Thumbnails Pane
() Slide Area
() Notes Pane

() StatusBar

13. These are used to switch between the views of the presentation i.e., Normal,
Slide Sorter, Reading and Slide Show view.
e Al g oglall (s all 48y sl (g ¢ gartill sl G s (3o s il sl 1 5 padiies
LA e e A8y yhay el A G e k(i A )
) Slide Thumbnails Pane
) View Buttons

) Notes Pane
) Status Bar

—— g, —

A Bl daal &y ppdan plal =¥ (S5 s cOPy.com dyika 521 4B piaa G shall gyan
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14.  Close a presentation keyboard shortcut
wﬂ!u'ﬂj_“ %Y&Mlh_}]qﬂ_)hahl
) Cti+w
Ctrl+C
Alt + W
Alt +C

———

15.  The placeholders on a slide can be sized and positioned as required.

alladll Cauan dadgo g dana ity Aag pll) (o Gl juaiall
() False
() True

16. Outline Tab shows an outline of the slides and text of each slide in the

presentation.

() True
() False
17. is probably the most used presentation software program.

plaaiul il o g yall gl il
) PowerPoint
Word
Outlook
Excel

(
(
(
(

— v —

18. Dotted border identifies where you can type text or insert

pictures, charts, and their objects.
A LSy Liall ile gua g ) gl 71 315 i) A pbelind Zapa i Adaiiall 3 gaall
) Placeholders
Slide Pane
Fit slide
Note Page
PowerPoint Presentation is savgd with the extension

J'I.)LY‘C.AL!M" _C_m._,u,.,-u uu_.ﬁ'ﬂ‘ u'a_)a.“

—

o - -
O - - -

() .docx
() .pptx
() .doc
() ptix

3 g Alal) dnalay 4, ppudaald plad I V1 (855 B Mk copy.com 4iSe (sl B giae (3 ghal) pgar
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20.  Which is not a Home Tab Group
HOME s b ol () O 5!
Clipboard
Slides
Paragraph
)  Mllustration

(
(
(
(

21. The "Reset" icon is not used to reset the position, size and formatting of the

placeholders on a slide to their default settings. N
gl N A 2 3 il peainl) (ausiil g paally g gall Bole Y pa355Y a4 i)

= Y
() True
() False
22. The icon is used to change the space between the

characters of selected text.
sdaall gaill i jal G Adlaall uadl 223055 4 g
) Line spacing
) Text spacing
() Character spacing
) Paragraph spacing

—

23. The " Clear All Formatting " icon is used to clear all applied formatting
Akl Qﬁyﬁﬂ\@qe&]raﬂﬁ" Ml@u“iﬁﬂ‘

() True
() False
24. icon is used to create a bulleted list on a slide.
dagdl) e i dlaad oLAY 02855 40

() Bullets
() Numbers
() Symbals
() Paragraph

3 gt L)) Al &y ppaad plal ~J 9V (S5 £ Mk cOPY.COM 4iSa (9] A ghaa (5 ghadl pgan
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25. The commands in this group enable you to format paragraphs of text
ol Gauiy ol eans Ao ganall (3 aly)
) Paragraph
Font

Drawing
Editing

—_—

26. Keybord shortcut for Left Alignment
el olilaall peliall da ) A Jlecin)
) Ctrl + L
Alt + L
shift + L
Space + L

—_—— —

27. Keybord shortcut for Justify Alignment is Ctrl +)
alalatiall slilaall @.IMI i_"n_,] ‘.,5 _)L.a.‘ai‘h"l

() True
() False
28. The icon is used to split text into two or more columns.
() Columns ’
() Rows
() Text
() paragraph
29. The icon is used to change the orientation of text to
vertical, stacked or rotate it to the desired direction.
s,n_,M'ldSJJL_lu.aﬂh_i\.iﬁl_,",ga‘,‘l.:.llc.h_,.uu..i_)a'ﬂabﬂ):ﬁﬂ(m g
() Text Direction
() Text Alignment
() Drawing
() Adjustment
3 g ALl Analy Ay et alal o Y (S5 B S copy.com 408 (2l A ghaa Gghall an
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30. __ group contains the main editing commands such as cut, copy
and paste.
Gually il g il Jia dus )l S eyl (o S ic yana
() Layout
() Clipboard
() Font

() Paragraph

31. Indentation determines the between a margin and text.
Shalgl) y paill O 233 Aaalall Adlaal)

() Distance

()  Height

()  Width

() Size

32. | isused to Apply Italic

Jiladl Jaall (Badail aniiug
() True
() False

33. Keyboard shortcut for Right Alignment
@qll a'l.:ﬂ.‘h'nu @Jml ;..:n_,l "13 _)L..AE.-Y‘

() Ctrl +R
() Alt +R
() Sshift +R
() Space +R

34. Keyboard shortcut for Center Alignment
Ao giall olanall pegtliall da gl 3 JLailY)

) Ctrl +E
Alt +C
Shift + E
Space +C

— e p—

3 grn AL} Al &y paad plal J 3V (S 5 £ L2 copy.com 4t (sl A gl (3 ghall ayen
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35.  The optionsin group enable to insert various kinds of tables

and spreadsheets.
iy SN Jglaall y Jglandl oy diliaa g ) g3l 71 oY Al rand
() Tables group
()  Images
() Links
() Text

jl.“-_,uﬂ.h‘ "-‘ ‘;'IJL.“"JI

36. You can change the size and position of a table as required.

slhae g LS Jyanll Jiiy paa a5 gpkind
() True
() False

37. The commands in this group enable to insert various types of images &

screenshots and create photo albums.
J‘,a..nn‘._,gll ;L&'JJM‘Q&A&‘}IC‘%&WE&N‘&M L’.i_).n'!‘,\”
) Images Group
) Links Group
) Text Group
) Layout Group

38. group commands is used to create links and add action commands
to object
_).I_,I_,l_})'li.ih.al_,.}n._ﬂ_,_);ua}".mu" i ic gaaa yayl
) Links Group
Image Group

(
()

() Symbols Group

() Media Group

39. The " Action" icon is used to add an action to object to specify what should

happen when click on it or over with your mouse.
U.n_,ul“'iﬁ._lk-m‘k oy i g La 2l @Lsn‘p’l:\ju‘f‘nﬂugaction ol

() True
() False

g ALl daaly & ppaad plad Jg¥ (S5 £ A4 copy.com 4 sal A giaa (§ghall gran
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40. The icon is used to insert various readymade illustrations,

audios and videos offered by PowerPoint.
Ciigs g0 5 b gia ppdy D gealy 3 AL Ampeia sd Cla gaa )
) ClipArt . .
Readymade Picture

Picture
Screenshot

P "-l
7| Y padiud el

— e, e
— — —

41. Thereare sizing handles along the edges of a table
Jsaall ana il gl Mlia

() Nine

() Ten

() Seven

() Eight

42. Onthe "insert" Tab, in the "Tables" group, select "Table" and drag with your

mouse to specify the dimensions of the table.
d_,.'\;..“.’ll.q'l.\gd;ﬂua_,u'l u.a:-.ul_,d_,hmd_,.\a.‘lic.ﬁagﬁcl_).ﬂ t._g_,.ﬁ‘.’.\

() True
() False

43. The Links group enables you to create links and add action commands to

objects.
CASH el b 1530 Al y Jaid gy LAY Sl asdl dal y ) Ao pana

() True

() False

44. The icon is used to insert Text Boxes in your presentation.

() TextBox
() Header and Footer
() Word Art
() Date and Time
3 e Ll daaly Ay jpuians plal V1 (S 55 £ Ak cOpY.cOM 4iSa (sl Akghaa (3 glall gyay
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45.  The "WordArt" icon is used to create stylized text with various special effects.
Al o 00 pa i e e 6L pa4505 WordArt )

() True
() False
46. The icon is used to insert the date and time on a slide.
: ol A b i gl g g Al paadas iy
() WordArt

() Dateand Time

() Slide number
() Object

47. From the "Text" group, select "Date and Time" icon the "Header and Footer”
window is displayed.
ol Jally )y glilly Gl el 33s i de gana (e
() True
() False

48. Select the format you require to automatically display the correct date and

time when they change, click the "Update automatically” button.
s ) die paaall i gy A G ey (A JSE mell Ly 5 A Sl a1
"l":llib - —: -
() True
() False

49. The commands in the Media group enable you to insert audios and videos in

the presentation.
il (o pall (& sy Gl peal 2] 3V Sl s ssa de sana (A el gV
() True
() False

50. The contextual "Playback" tab displayed when you insert a video.
_,_.pgicl_).ﬂ die e o "Jaaddll sole "‘,SLL...J_ by ol

() True
() False

3 gn ) Anala 4y ppaiaad plal I (553 £ i cOpY.COM 43S (gl 45 giaa (5 ghall Y
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51.  You may use the Start Time and End Time boxes to specify the part of the

video you want to play.
AL 3 53 g3l il ¢ o wasdl elgY iy el i g ey ya pladid iSay

() True.

() False

52. The___ iconis used to insert an audio clip into a slide.
,-‘u:h-_i_):lusu:l)@ck-uc'u.‘ly }Jll‘.'lai:lnhﬂg
Equation
Symbol
Video
) Audio

_— e —

53.  You can also change the orientation and size of the slides
,cslﬂlﬁa,.mlﬁﬁ@lm

() True

() False

54, The "Themes" gallery is used to apply a "Theme" to a presentation

A e o "Gull” () "Bl 2 sm i
() True
() False

55. The "Background Style" icon is used to change the background style of the slides.
A Dl o ) "R i ) a2l o3

() True

() False

56. Inthe format background window, ensure that "Fill" is selected in the left
pane. Select "Picture or texture fill" in the right pane.
eall b "oualdl o155 geall eda” 2aa a1 e jadl B Al aaa5 (e S ¢ Gaaill Aila 330 A

oY)
() True
() False
dgnen lal) Analy 4y pans plat oI V1 (S5 B S copy.com 4ia 52 Al ghaa (3 shal pger
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57. is an entrance animation that is applied to a slide as a
whole when that slide is displayed.
Al 03 (g je o Laie JSS day pa e dindd 4y & jate pu) A,
() Transitions

()  Design
() Animations
()  Slide show

58. Add Animation is used to add an additional animation effect.
38 jatiall o gyl il 5 AiLaY A8 jatall  ge M AiL) pladiul o

() True
() False
59. Button is used to preview the transition applied to the current slide.

Al el o o) A Rlad) 530 adTy
() Print Preview
() Review

() Preview
() View

60. Timing is not related to the timing of animation effects.

() True
() False

61. Animation Pane is not used to create custom animations

Aanadia 48 jala p gy ¢LAY A8 a0l o gua )l 6 o pladiiul o Y
() True
() False

62. Transition This Slide is used to specify transition effects to a slide
Aay b U'“ Jay) t;l‘_)y.t Laadl day 4l 1 PRCY Jasy)

() True
() False

A e ALl dnaly &y jpuaad plat =d V1 S5 £ L cOpy.com 45iSa (s} Ui g (3 ghall ppan
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63. The preview command is used to give Timing to a slide.
oyl ) Cu i elhe Y Lilea jadl pladlul o
() True -
() False

64. The "Apply to All" icon is used to apply the same transition effect as the

current slide to all slides in the presentation.
o AN maas ) Alall dag 2l (e JaEY) 2l s 3k UK e Bl e pladdud o

gl (yia yadl
() True
() False
65. Onthe "Transitions" tab, in the group, click the dropdown
arrow in the "Sound" box and make your selection
b Dol pgudll e il ¢ Ze yanall b "SYEEYI cypl Adle
Ll saa "i-:-IJA-ﬂ-“'. ca)d'l
() Duration
() Appear
() None of these
() Timing
66. The" "icon is used to apply the same transition
effects as the current slide to all slides in the presentation
dag Hal Jia AIEEY) Al i Gaaad] " Sl aladdial a3

,q..._:.\isli Ul ‘.,s c.‘ﬂ ol A8S ) il
) ApplyToAll
Duration
Timing
Sound

(
(
(
(

T S

67. The icon is used to add an additional animation effect

to an object.
S ) ilin) S paia p gy i3 dilia sl pladil
) Add Animation
) Remove Animation
) Apply Animation
) None of these,

3 g L) el &y prnad slal | g (8 53 £ L& copy.com 4Sa sl 4B ghas (3 ghall ey
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68. The is used to create custom animations.
: s 1
Aaadall 4S il r_,m_)l] AR {:ha..m P
()  Add Animation
()  Trigger
() Animation pane
() Animation painter
69. tab contains tools that helps you control the way your
presentation is displayed to an audience. .
Gl s Ak 8 pSadll G dlaelud Gl e <yl G5
seaall el
() Slide Show
() Insert
() Design
() Animation

70. These tools allow you to run a slide show, customize other related settings

and hide individual slides
clll_)..n.“ elisd) alall &l LF__P"-N 5_11..\‘3:-\” UMJ_, c.ﬂ)u e aaly Ql_’J’Y'I oda &l ca...n.l

Al
() Transitions Tab
() Design Tab
() Slideshow Tab
() Review Tab
71. The icon is used to run your presentation starting from
the first slide.
s Aag pall (e ledy (el ia pall Jaail ey pladiud 5

) From Beginning

From Current slide
From Starting

— — p— g—
— S St

From Last
Agran L) daaly 4y jans gl I (8 5 £ L& copy.com 48 (53 A giae (3 ghall gan
©ashraf 2017 606 ~ 0599814114 gﬁ,.udl oyl )

Scanned by CamScanner



G Microsoft PowerPoint 2016 -

. group, select "From Beglnnmg

72. On the "Slide Show " tab from the "
gl e" 2 ("

() Set Up

() Monitors

() StartSlide Show
()  Timing

73.  Key board shortcut for running presentation From Beginning.

.43‘.\:1." Ly r.a.\l.ln _}IJI ‘J.u.uJ c.flln]’l ‘..'a-_,l JL..AI&‘

() F2
) F7
) F12

) FS

74. Keyboard shortcut to run the slide show starting from the

current slide. Slide show begins on screen starting from the current slide.

oase 1o Adlall Aoy p20 (e ey il AN e il cdall da gl jlsidl
Al 4.-;.1_,...]1‘_,..!;:._14..-1.....11“.:.&.:\_)..1'.

)  Shift +F5
) ctrl +F5
) Alt + F5
) Space + F5
5. If you do not wish to change what you have typed just click in
spelling check.

eyl sl i L Ll Caal L il b 5 Y S 1)
() Ignore

(
(
(
(
7

() Change
() Add
() lgnore All

76. If the word appears many times in the presentation then you don't wish to

change what you have typed

() Ignore
() lgnoreAll
() Change
() Change All
3 e L) daaly & el plal =J oY1 (S5 B LS cOpy.com 4Sa (sl AR ghaa (§ghad) aran
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77.  To correct a word, you may highlight one of the suggestions displayed or

manually correct it by typing the correct word in the " " box.
3 30 b Rl A 4S5 Uy Lt 5} Ay peall el Y1 0] e y0n ol cle 2 ppmnad

() Change to
()  Change
() Change All
() Suggest
78. A is a way of looking at a presentation.
() View
() Review
() Change
() Zoom
79. The view is the main editing view which you use to create your

presentations.
el m g jall eL2Y Ladiiad (I Apuasi )y adl i pe ik
) Normal
Slide Sorter

Notes Page
Reading

(
(
(
(

80. The" " view presents your slides in thumbnail form to show
you an overall picture of presentation.

waall ) geall aasan Al jeladl jiiaa JS5 B Al N Y _ " o padl e

) Slide Sorter
Normal
Notes page
Reading view

o p—

81. The " Normal" view has four working areas (Outline tab, Slides tab, Slide pane, Notes

pane)
Jandl ¥l Aay )l 4l "gile” o
() True
() False
3 g Al Ay 4y ppdaal plal =S¥ S 53 £ L copy.com 4 sl Al ghaa (3 kel apay
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82. The ___view shows your notes in full page format in presentation

@il el 3 ALS dadia JS3 A Cilaal) ey Uae
() Slide Sorter
() Normal
() Notes page
() Reading view
83. The is similar to the Slide Show view but difference is that the title

bar status bar and the windows task bar are displayed.
e 1y paiyy alead) day pl y ) giadl day y day pl Gl g G STy A e e gl e Apls

Slide Sorter

Normal

Notes page

)  Reading view

84, Slides can be created using different layouts, each layout is based on a slide inthe _____
wh a8 le Taglads (IS ity g il illagladd aladiuly il 2l olii) (S
) Slide Master

) Layout Master
)

)

— — — —

(

(
( Notes Master
(

Handout Master

85. The tab "View"in" " group, click "Slide Master" then it
displays number of slide icons in the left pane. It contain different layouts
r: "J:LHILA i&-}_)n:]'l" L:’Js -}i.-ll' ‘1;-,‘?-‘]1 L} " ‘;j “u.ﬂﬁ" ‘.._‘."-’-.‘3“ 1‘};

e e Jadl (g Aay 80 5 pa Ml (e 22 (g s
{) Show
() Masterview
( Presentation Views
(

Window

86. We can save PowerPoint slide show in extension.

" JlﬁaY|q§u'a_}l.“1h:Jh..| ﬁ|y}yelﬂ1wﬁhm‘g
() .ppsx
()  .ppix
() pstx
() -PpX

3 gt L) el 4y ppunal plal =l g¥1 (€5 £ L& cOpy.com 438a (s A3 ghaa (3 gkl agan
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The changes made to a are reflected on all slides

throughout your presentation which are based on that layout.

oAl A A8l asea e wle W3 pa) o5 A il G e 62
° apmal) 138 Y 5505 (g (i
() Masterslide
() slide show
() Normal
()  Hide Slide
88. A PowerPoint presentation is saved with the extension ".pptx".
".pptx",a'l..ﬁnY| o il 9 3 e L.,.A-'I‘.'li:l Ua e Laaa ‘aﬁg
() True
() False
89. The "Notes Page" view shows your notes in full page format.
ALY dadeal) Bl dhilaa e "cillaadla) dadia" (e je Al yh (o yad
() True
() False
90. The "Spelling" icon is used to check the spellings of text in your presentation.
W el paill elaa (e @iadll MDY GAYI" 3a ) plasdul o)
() True
() False
3 g dlad) daaly &y ppuanl plal IV S 5 & LS copy.com 4438a 5] Al ghae (3 shal) gpan
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